Verifica e identificazione della perdita di
pacchetti nella WAN per SD-WAN
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Introduzione

Questo documento descrive come identificare e raccogliere i dati quando il traffico sulla WAN & in
perdita ma sul perimetro SD-WAN non si osservano cadute.

Prerequisiti

Requisiti
Cisco raccomanda la conoscenza dei seguenti argomenti:

- Software Cisco Defined Wide Area Network (SD-WAN)
- Embedded Packet Capture o vManage Packet Capture
- Wireshark

- Microsoft Excel

Componenti usati

Le informazioni fornite in questo documento si basano sulle seguenti versioni software e
hardware:

. C800V versione 17.03.04
- vManage versione 20.3.4
- Wireshark versione 2.6.3

Le informazioni discusse in questo documento fanno riferimento a dispositivi usati in uno specifico
ambiente di emulazione. Su tutti i dispositivi menzionati nel documento la configurazione & stata



ripristinata ai valori predefiniti. Se la rete € operativa, valutare attentamente eventuali
conseguenze derivanti dall'uso dei comandi.

Sfondo

Per raccogliere questa sfida, la procedura descritta in questo documento mostra come
contrassegnare il traffico specifico con DSCP (Differentiated Services Code Point) per aiutare a
identificare i pacchetti desiderati. Il protocollo DSCP pu0 essere utilizzato per identificare il traffico,
in quanto questo valore viene copiato dall'intestazione del pacchetto interno all'intestazione IPsec.
Una volta identificati i pacchetti desiderati, viene mostrato come far corrispondere il traffico su due
WAN acquisite per garantire il traffico tra 'origine e la destinazione.

Per dimostrare questa tecnica di risoluzione dei problemi, vengono usati due singoli siti router. In
questo caso, il traffico ICMP da 10.0.0.10 a 10.0.2.10 sotto forma di 100 ping, come mostrato
nell'immagine. In questo esempio non vi € alcuna perdita, ma viene utilizzata la stessa tecnica di
risoluzione dei problemi nel caso in cui vi sia una perdita per identificarla.

10.0.0.10 ; . 192.168.23.149 192.168.28.240 10.0.2.10
A A
"4 "4
cEdge1 cEdge3

Risoluzione dei problemi del processo

Processo di panoramica

1. Per il traffico tracciato sulla WAN, & necessario un elenco degli accessi (ACL) (o criterio
centralizzato) per contrassegnare il traffico con un valore DSCP inutilizzato. Nell'esempio
viene utilizzato DSCP 27.

2. Dopo aver contrassegnato il traffico, I'acquisizione dei pacchetti incorporata viene utilizzata
per acquisire i pacchetti sull'interfaccia di trasporto del router di origine e di destinazione.

Nota: € possibile utilizzare anche vManage packet capture, sebbene sia previsto un limite di
5 MB di dati o 5 minuti di runtime.

1. Una volta acquisite le immagini, aprirle in Wireshark per visualizzarle.

2. Il filtro viene applicato in Wireshark per mostrare quali pacchetti sono desiderati e quindi
vengono confrontati.

3. Microsoft Excel viene utilizzato per le acquisizioni di grandi dimensioni per garantirne
l'accuratezza.



Contrassegnare il traffico desiderato con DSCP

Un elenco degli accessi, come nell'esempio, € configurato sul router di origine (cEdge1
nell'esempio) e applicato all'interfaccia nella parte SD-WAN della configurazione del router, come
mostrato.

Viene applicato un contatore facoltativo per verificare che il traffico raggiunga il criterio come
previsto. Per verificare questa condizione, usare il comando show sdwan policy access-list-
counters.

policy

access-1ist mark_dscp_27
sequence 10

mat ch

source-ip 10.0.0.10/ 32
destination-ip 10.0.2.10/32
1

action accept

count MARK DSCP_27_ COUNT (optional counter to verify packets that hit the policy)
set

dscp 27

!

1

1

defaul t -acti on accept

sdwan
interface G gabitEthernet3
access-list mark_dscp_27 in

Acquisire il traffico con I'acquisizione integrata

Nota: come configurare I'acquisizione di un pacchetto incorporato in Cisco I0S XE per
acquisire i pacchetti crittografati che attraversano la WAN, passare all'esempio di
configurazione di Embedded Packet Capture per Cisco 10S e Cisco 10S XE

Nota: per limitare 'EPC sulla WAN €& necessario utilizzare un ACL, in quanto il limite di
velocita per I'EPC potrebbe essere superiore a 1000 PPS.

Esempio

Un ACL é configurato su cEdge1 e cEdge3 poiché nell'esempio riportato il traffico viene controllato
solo nella direzione da origine a destinazione.

Nota: gli indirizzi IP WAN vengono utilizzati per filtrare I'acquisizione. Per identificare il
percorso del traffico e identificare gli IP WAN corretti per il filtro ACL, € possibile usare piu
output. | comandi che possono essere utilizzati per generare questo output sono i flussi
cflowd show sdwan app-fwd e il percorso del servizio criteri sdwan. Passare alla traccia del
pacchetto condizionale per la condizione di debug.

ip access-list extended CAP-Filter
10 permit ip host 192.168.23.149 host 192.168. 28. 240


https://www.cisco.com/c/it_it/support/docs/ios-nx-os-software/ios-embedded-packet-capture/116045-productconfig-epc-00.html
https://www.cisco.com/c/it_it/support/docs/ios-nx-os-software/ios-embedded-packet-capture/116045-productconfig-epc-00.html
https://www.cisco.com/c/it_it/support/docs/content-networking/adaptive-session-redundancy-asr/117858-technote-asr-00.html
https://www.cisco.com/c/it_it/support/docs/content-networking/adaptive-session-redundancy-asr/117858-technote-asr-00.html

A questo punto, le riprese vengono avviate su entrambi i router e vengono inviati 100 ping
attraverso la sovrapposizione.

#ping vrf 10 10.0.2.10 rep 100
Type escape sequence to abort.

Sendi ng 100, 100-byte | CWP Echos to 10.0.2.10, tineout is 2 seconds:
{0 A I I A |

Success rate is 100 percent (100/100), round-trip mn/avg/max = 1/1/4 ns
Dopo aver interrotto le clip e averle raccolte da entrambi i router, occorre aprirle in Wireshark per
visualizzarle.

Analisi tramite Wireshark

Una volta aperta l'acquisizione cEdge1 in Wireshark, si osservera che tutto il traffico & crittografato
e non e facile decifrare i pacchetti che sono stati inviati.

Ml cahpoap - a
Fie [dt Vew o Copture Anshge St Tekphomy Wi Took  Help
Am;e REBR«=FTilEaaan
] = 10
P Time Source [ Prosocnl  Leng®h ESP Sequence Differeniated Servces Codepont  SourcePort  DeswationPort  Sequencebmber  lofo
[ 1]0.000000  102.168.23. 140 102.168.28_ 240 e 178 aa 20384 »
2 0.383088  292.168.23.34% wor 148 32388 +
3 0.5035% e 178 22388 = 1
41420978 e 148 22386 = 1.
5 3.896530 wor a7s 32386 + 3
& 2.40797; e 18 FEET
7 2.7929%8 e 17 12386 = 1.
83,0273 192, woe 148 32386 = 1
9 2. 7R18%7 X o s 13384 - 1.
10 &, 145588 o 168 Clax: 12386 = 1.
31 8,769549 e a7 Clazs Selectsr & 32286 = 1
12 4,5819%% oo 148 Clazs Selector & 1386
11 5.7225% P 7S lass Selector & 2386
14 5. 57054 o 168 Class Selector & 2186
15 6.502861 e 175 Clase Selector & 2386
16 6.5349559 e 163 Class Selector & 2386
17 7.348580 e 175 Class Selector & 2384
18 7503599 [ 168 Class Selector & 12386 -
19 8.293550 wop 175 €lass Selector & 12386
0 8. 774853 e 168 Class Selectar & 12386
2 9.25159) P 75 €lass Selector § 12386
12 9653557 we 163 Class Selector & 12386
1 10.0axse8 e 175 Class Selectar & 12385
24 10.564357 e 168 Class Selector & 12386
3 1b. 54580 [ 175 €lass Selector & 13386
6 11.416978 [ 162 Class Selecter & 12386
37 11,9375 ok 175 €lass Selecter & 12385 = 1
3 13 a066E4 ok 168 Class Selecter & 13385 = 1.
1 12.836808 ok 178 Class Selecter & 12386 =
3 13266984 ok 168 3 12385
3 13 7reRE ok 17 3388
32 14.171988 [ 176 12386
33 1417386 o 176 12386
(TRTR o 17 12388
35 14.175985 192.1 wor 176 12386
3 B4 ATEATT 293 b 17 23588
37 16.ATTT 192 102.268.28_288 wor 178 22588
3 14.7EM 292, : 192.268.28.290 wor 178 22388
3 1a.1BERN0 102.168.33.1 193268, 38.388 b 17 22588

Filtrare questa acquisizione con un filtro di visualizzazione ip.dsfield.dscp == 27, si osservera che
nella parte inferiore dello schermo vengono visualizzati solo 100 pacchetti e che il valore della
colonna DSCP mostra tutti 27.



Adm @ RE g s

B g deteid ducp == 37

. Tme Scurce
45195,44196) 192.168.20.149
452 55,445976 19216870149
453 55,448966  190.163.20.149
ATE 55, A%0965  197.168.70.145
455 55452064 107.148.2).240
4536 35, 44563
457 55,4859
458 55.456077
458 55.457368
460 55,458975
461 55,461966  192.163.23.149
463 55,463565 191.168.10.148
463 55465564 191.163.10. 149
468 35, 466971 190.164.30.149
465 35.467562 192.148.70.140
460 35,469961  192.148.23.140
467 35470068 103.148.33.148
468 55471975 192.168.70.149
469 55470967 192.168.20.149
470 55.474366  192.168.73.149
471 5,475973 192.168.20.149
AT 55, ATEFES  197.168.10.145
470 35, 478561
ATH W5, ARG
47 35.481560
476 35484075
477 35.485967
478 55.4a7966 192
479 55,4383 192,
480 55.431563 192,
481 55,508961 1
483 55,510959 1
483 35, 311560
484 35,30365 &
483 35.30472 1
486 85516071 102.148.73.140
487 55,5963 192.168.23.149
488 55.520950  193.168.33.149
49 149

=] LLLY

Destrason
192,168.28.240
192,168, 18. 288
192,168, 28,280
192.148.28. 240
192.168.28. 260
192,248, 28. 250
193.148.28. 258
192.168.28. 268
193,148, 38, 388
19,168, 38, 388
192,168, 28. 250
153,168, 18, 388
192,168,218, 280
192,160.29.240
192.148.28. 240
192,248, 2
193,148

.2%8

192.168.28. 258
192,168.28.290
192,168, 38, 388
192,168, 28 280
192.165.29. 280
192.168.28. 240
192,160, 20, 250

19316828 328
192164 18. 280
193,164 18. 386
192.164.18. 240
192,169.29.240
192.164.20.340
192,368
192.168.38. 290
18216828350
192,168 38,290
193,164 28. 228
192, 250
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Frame 451; 176 bytes on wire (1488 bits), 176 bybes captured (1480 bits)
Etbernet 17, Src: Vhesre_Bhiaf 43 (00:30:30:84:09:45), Dit: Wheare_B4ie2:57 (00:30:56:04:e2:67)

Interset Protocol Versdon 4, Src: 192.165.23.149, Dut: 192.168.75.240
Uier Batagram Protocsl, Sre Pork: 13385, D4k Ports 13887

Data (134 bytes)

B2 5 56 B4 o2 b7 OF S0 36 84 af 35 08 W A5 6c PV P ¥ E £l

@ 7 copan

In alcuni casi in cui il valore DSCP viene mantenuto sulla WAN, lo stesso filtro pud essere
utilizzato sull'acquisizione di destinazione.

In altri casi, cid non & possibile, ad esempio in una situazione in cui il valore DSCP viene

176
176

cancellato attraverso una connessione Internet pubblica.

Filtra il traffico desiderato per sequenza ESP

In entrambi i casi, il traffico pud essere identificato con i numeri di sequenza ESP.

Per visualizzare i numeri di sequenza ESP nel pacchetto, fare clic con il pulsante destro del
mouse sull'acquisizione e scegliere Decodifica come mostrato.

Seqamron Number

o
12396 - 13487 Len-134
12086 - 12407 Len=1M
12086 + 13407 Len=1M
12086 =+ 12407 Len=1}4
12386 + 12407 Lensll4
12386 + 33407 Len=134
12386 = 12487 Lens124
« 12487 Lenel34
- 13687 Lemeild
= 12487 Lemsil4
12407 Len-134
3487 Lene13d.
12407 Len=134
22407 Leneie
12487 Lene134
32487 Len=134
- 13487 Lenei34
s 13487 Lemsile
- 22487 Len=134
- 13487 Lene134
12407 Len=134
12407 Lens

12
22407
212487 L
12407
- 12487
- 12487
- 12487
12487
12487 Len=

- 32487 Len=134
- 13487 Lenn134
= 12487 Len=134

Profie: Deladt



Mark/Unmark Packet

Ignore/Unignore Packet
Set/Unset Time Reference

Time Shift...
Packet Comments

Edit Resolved Name

Apply as Filter
Prepare as Filter
Conversation Filter

Colorize Conversation
SCTP

Follow

Copy

Protocol Preferences

Show Packet in New Window

Ctrl+M
Ctrl+D
Ctrl+T
Ctrl+Shift+T
»

Selezionare il menu a discesa Campo corrente e in tale campo digitare UDPENCAP o

selezionarlo dall'elenco a discesa.

12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386
12386



M Wireshark - Decode As...

Field Value Type Default Current

UDP port 12386 Integer, base 10 (none) |(none)
3GPP2 AN
A1
ACDR
AcCtrace
ADP
ADwin
ALC
AMP

a0

[ox ]| save |[copfion | cancel || e
Al termine, selezionare OK.
‘ Wireshark - Decode As...
Field Value Type Default Current

UDP port 12386 Integer, base 10 (none) UDPENCAP

All'interno della sezione Wireshark Packet Details, espandere la parte Encapsulating Security
Payload del pacchetto per visualizzare la sequenza ESP.



A7Q B8 ARRGTR 147 1AR 23 144 142 1AR 2R 244 Fsp 17/
<

> Frame 464: 176 bytes on wire (1408 bits), 176 bytes captured (1488 bits)

> Ethernet II, Src: VMware_84:af:45 (@0:50:56:84:af:45), Dst: VMware_84:e2:b7 (00:50:56:84:e2:b7)
Internet Protocol Version 4, Src: 192.168.23.149, Dst: 192.168.28.240

> User Datagram Protocol, Src Port: 12386, Dst Port: 12487

UDP Encapsulation of IPsec Packets

Encapsulating Security Payload

ESP Sequence: 319

Fare clic con il pulsante destro del mouse su ESP Sequence e scegliere apply as column in modo
che la sequenza ESP possa essere visualizzata come una colonna nella sezione Packet List nella
parte superiore della schermata Wireshark.

456 55.4 ESP
457 55. Expand Subtrees ESP
458 55.¢ Collapse Subtrees ESP
459 55.¢ Expand All ESP
.
il Collapse All ESP
461 55. ESP
462 55. Apply as Column Ctrl+Shift+I ESP
463 55. ESP
464 55.¢ Apply as Filter > ESP
Sz Prepare as Filter ’ ==
466 55.4 ESP
467 55.¢ Conversation Filter » ESp
468 55.4 Colorize with Filter > ESP
469 55.< Follow b ESP
478 55.4 ESP
471 55.4 Copy 3 ESP
472 55.¢ ESP
473 55.¢ Show Packet Bytes... Ctrl+Shift+0 ESP
474 55.¢ Export Packet Bytes... Ctrl+Shift+X ESP
Wiki Protocol Page -
Frame 464: 176 byt ) ] 8 bits)
Ethernet II, Src: ' Filter Field Reference e _84:e2:b7 (@
Internet Protocol Protocol Preferences 4 .240
User Datagram Prot:
Encapsulating Secu Go to Linked Packet
—————— - Packet in New Window
ESP Sequence: 3.

Nota: l'indice SPI ESP per i pacchetti su cEdge1 € 0x040001dc. Utilizzato per un filtro
sull'acquisizione di destinazione.



Frame 464: 176 bytes on wire (1408 bits), 176 bytes captured (1408 bits)
Ethernet II, Src: VMware_84:af:45 (@0:50:56:84:af:45), Dst: VMware_84:e2:b7
Internet Protocol Version 4, Src: 192.168.23.149, Dst: 192.168.28.240

User Datagram Protocol, Src Port: 12386, Dst Port: 12407

UDP Encapsulation of IPsec Packets
v [ ] =& ' = i - = - .

SP SPI: @x@40@0ldc (67109340

ESP Sequence: 319

Aprire l'acquisizione di destinazione, ripetere i passaggi per decodificarla come UDPENCAP e
visualizzare i numeri di sequenza ESP nei pacchetti.

Una volta che i pacchetti visualizzano il numero di sequenza ESP, lo SPI ESP della prima
acquisizione puo essere utilizzato come filtro sulla seconda acquisizione per visualizzare solo il
traffico all'interno di tale SPI che corrisponde al traffico desiderato.

I numeri di sequenza dei pacchetti che corrispondono a entrambi hanno il contrassegno DSCP 27.

[ - - a
Fie Bdt View Go Cophwe Ansbre Sistnbics Teephony W ook M
imi® RE iscETiEEaaan T B TR
- ETLS
igzamas — — e
 togrce e T N T ) - — = — — <
I Ledt] —r g b A 192.160.20. 200 e 176 200 efaalt £S5 (5P
et N TR TR e m & [
g NI el :UIMI«} m—ﬁv——\_.m_ 5 (SFIe
'x :: = :; :;::m’:) 192.168.28. 300 [ 17 ﬁ £ (ST
| = e 192,148, 28. 248 ] 17 [
r T
= i g e 192.168.28. 200 ese 17 208 27 5P (S
" w2 el b 162,140,380, 308 e ™ 35 1 5 (S
B Yoez L 192.148.28. 240 e ”e ne 17 5 (SPIe
i e bl 192,148,328, 140 £sr 17 n 35 (i
I e | 192.148.38. 308 ] 17 aue e (o
u a7 / 'w'_"m' = 192,168, 28, 260 e 17 ns 7 £ (ST
e i P T waeame 1 Pyl 55 (g
= { 3 192,168,280, 140 e 1 ns 7 [
e R / = I:':“’“::; 192.148.38, 140 tsr 1 ne 7 3 (sl
i e 163148, 58, 2eb (123 i §F R (Lh el
o T
:0 :ll 7 / - 'g :“"‘"""] 192,168,380, 240 ' 17 ns 7 5P (ST
N ) Pl =g 192,140,280, 200 s 17 ne 27 55 (5P
/ ( imgmm 192.168.28. 40 ) 1 ae 1 i,
e = = = |:t1m::; 192,148,328, 140 tse 1 ) 5# (5P
i 163148, 58, 2eb (123 i 83 3 (Shel
X 17 e
,’: ':,‘ T / :3 I::': um::] 192.168.28. 200 s 1 2 2w £ (S
L= = / == m] EH.168.28. 200 s i 34 37 L5 (51
t e = :wmm‘ 62,148, 10, 266 e " [ 58 (SPI
/ ( ) = 192.148.28. 160 ) 17 206 17 [y
« » »
<
Frame 4311 176 bytes on wire (1688 BIRS), 176 bytes capfured (LOBE Bits) Frame 4432 176 bytes on wire (1488 bita), 176 bytes captured (1488 bits)
Ethernet 11, Seci Whmre SA1af145 (00130156184101 1457, D11 Vhasre BA1e11T (BO1S0156184162187) Btharnat 11, Src: Whamre_S4:af145 (00:50:56:84:a1145), Dut: Vasre_SAte2tb7 (00:50:56:B4te2tbT)
Intermet Protecel Version 4, Srei I00.168.20,140 Deti 192.160.20. 240 Internet Protocel Version 4, Srct 192,164.23.049, Dat: 192.168,20. 340
Uer Outagram Protocal, Sre Port: 12386, Dut Perts 10607 Usér Betagres Pratocsl, See hort: 12046, Dat Port: 13407
0P Entapiulation of Piec Packets - \oP Encapsulation of IPsec Packets
w Ercapruiating Secerity Puylosd
ESP SPI1 MwbAOMIISC (6THORIR)

Questo confronto puo essere eseguito manualmente in Wireshark oppure puo essere utilizzato
per eseguire questo confronto.

Per poter utilizzare Microsoft Excel per il confronto, & necessario suddividere in porzioni entrambe
le clip in modo che contengano solo i pacchetti che si trovano in entrambe le clip.

Nell'acquisizione di origine, il primo pacchetto rilevante ha la sequenza ESP 306 e corrisponde al
numero di pacchetto 451.

A
AdAm2® RE QoG L5 =EAQQH
[ Tip.dsfield.dscp == 27 [X] -]+
No. Time Source Destination Protocol  Length ESP Sequence Different "
| 451 55.441963 192.168.23.149 192.168.28.248 ESP 17e 306 27
452 55.445976 192.168.23.149 192.168.28.248 ESP 176 387 27
453 55.448966 192.168.23.149 192.168.28.248 ESP 176 3es8 27
454 55.450965 192.168.23.149 192.168.28.248 ESP 176 3e9 27
455 55.452964 192.168.23.149 192.168.28.240 ESP 176 31e 27
456 55.454963 192.168.23.149 192.168.28.248 ESP 176 311 27
457 55.455978 192.168.23.149 192.168.28.248 ESP 176 312 27

458 55.456977 192.168.23.149 192.168.28.248 ESP 176 313 27



L'ultimo pacchetto rilevante nell'acquisizione di origine ha la sequenza ESP 405 ed € il numero di

pacchetto 550.

548 55.608962
549 55.6@9969
550 55.61e960@

192
192
192

.168.23.149
.168.23.149
.168.23.149

192.
192.
192.

168.28.
168.28.
168.28.

249
249
249

ESP
ESP
ESP

176
176
176

403 27
484 27
405 27

Nell'acquisizione di destinazione, il primo pacchetto rilevante corrisponde all'acquisizione di
origine con sequenza ESP 306, ma in questa acquisizione ¢ il pacchetto 463.

461 60.522028
462 60.715026
463 60.9990e8

464 61.003006

192.168.23.149
192.168.23.149
192.168.23.149
192.168.23.149

192.168.28.240
192.168.28.240
192.168.28.240
192.168.28.240

ESP 168
ESP 175
ESP 176
ESP 176

487 Class S¢
488 Class Se¢
3e6 27
3e7 27

L'ultimo pacchetto rilevante € presente anche con la sequenza ESP 405 ed ¢ il pacchetto 564.

5be bl.1lb5¥>Z
561 61.166043
562 61.166043
563 61.431029
564 61.584021

192,
192.
192.
192.
192.

1b8.25.149
168.23.149
168.23.149
168.23.149
168.23.149

192,
192.
192.
192.
192.

1bE.28..298
168.28.240
168.28.240
168.28.240
168.28.240

ENF
ESP
ESP
ESP
ESP

1/6
176
176
168
175

483 2/
44 27
485 27
489 Class St
41@ Class 5S¢

A questo punto, la prima acquisizione deve essere suddivisa in porzioni in modo da includere solo

i pacchetti rilevanti.

Passare a File > Esporta dissezioni pacchetti > Come CSV...

A CAP.pcap
File Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help
Open Ctrl+0 ED D SIE QA H
Open Recent »
Merge... Destination Protocol Length E
Import from Hex Dump... 149 192.168.28.240 ESP 176
Close Ctrl+ W 149 192.168.28.240 ESP 176
149 192.168.28.240 ESP 176
Save Ctrl+S 149 192.168.28.240 ESP 176
Save As Ctrl+Shift+S 149 192.168.28.240 ESP 176
149 192.168.28.240 ESP 176
File Set » 149 192.168.28.240 ESP 176
149 192.168.28.240 ESP 176
Export Specified Packets... 149 192.168.28.240 ESP 176
Export Packet Dissections > As Plain Text.. il . o
) .240 ESP 176
Export Packet Bytes... Ctrl+Shift+X As CSV... 240 ESp 176
Export PDUs to File... As "C" Arrays... .240 ESP 176
Export TLS Session Kevys... . 240 ESP 176
e S AsPSMLXML.. | 240 — o
i 3
Bxport Objects AsPDMLXML..  |.240 ESP 176
Print... Ctrl+P As JSON... -240 ESP 176
. 240 ESP 176
Quit Ctri+Q 149 192.168.28.240 ESP 176
Y%7 -9TOv0TOL—IrTZ T Io0 Tz 149 192.168.28.240 ESP 176
548 55.608962 192.168.23.149 192.168.28.240 ESP 176



Selezionare Acquisito e Intervallo e nel campo Intervallo digitare I'intervallo dal primo pacchetto
rilevante all'ultimo pacchetto rilevante.

Immettere un nome file nel campo Nome file e fare clic su Salva.

Savein:

*

Quick access

Desktop

Libraries

—

This PC

S

Network

M Wireshark - Export Packet Dissections

X
I Desktop v @ F 2 A
Name a Status Date modified
No items match your search.
L4 >
File name: CAP1_slice v Save
Saveastype:  CSV (Comma Separated Values summary) (*.cs' v Cancel
Help
Packet Range Pack
(@ Captured () Displayed P
(O All packets 880 10C E
(O Selected packet 1 1Pz
Marked packets I ;
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Ripetere la stessa procedura sull'acquisizione 2 per i pacchetti interessati.
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Aprire entrambi i file CSV in Microsoft Excel.

Sul file CSV di acquisizione di origine, salvare come formato XLSX.

Save As
@ Recert ']" [F= Desktop
lC.ﬂP]_ince |
Cisco | Excel Warkboak (*xlsx) 'I. [EF save |

Nella parte inferiore dello schermo, selezionare il simbolo + per aggiungere un altro foglio.
Denominatela CAP2_slice.

1| 485 55.51497 192.168.2:192.168.2EESP 176 340 27 ESP (SP1=0x040001dc)
486 55.51697 192.168.2:192.168.2¢ ESP 176 341 27 ESP (SPI1=0x040001dc)
487 55.51796 192.168.2: 192.168.2ESP 176 342 27 ESP (SPI=0x040001dc)

CAP1 slice @

Aprire il file CSV CAP2 e premere CTRL + a per selezionare tutto e CTRL + ¢ per copiarlo.



Passare al file CAP1_slice.xlIsx e nella seconda scheda di CAP2_slice incollare (CTRL + v) le
informazioni copiate nella cella A1.
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1 :No -Time -Source -Destinatic-protoco] -Length -ESP Seque.Differenti-Source Po-Destinatic-Info -SequencelN
2 | 463 60.99901 192.168.2:192.168.2L ESP 176 306 27 ESP (SPI=0x040001dc)
3 | 464 61.00301 192.168.2:192.168.2{ ESP 176 307 27 ESP (SPI=0x040001dc)
4 | 465 61.00506 192.168.2:192.168.2L ESP 176 308 27 ESP (SPI=0x040001dc)
5 | 466 61.00706 192.168.2:192.168.2¢ ESP 176 309 27 ESP (SPI=0x040001dc)
6 | 467 61.00905 192.168.2:192.168.2¢ ESP 176 310 27 ESP (SPI=0x040001dc)
7 | 468 61.01006 192.168.2:192.168.2¢ ESP 176 311 27 ESP (SPI=0x040001dc)
8 | 469 61.01105 192.168.2:192.168.2¢ ESP 176 312 27 ESP (SPI=0x040001dc)
9 | 470 61.01305 192.168.2:192.168.2¢ ESP 176 313 27 ESP (SPI=0x040001dc)
10 471 61.01406 192.168.2:192.168.2¢ ESP 176 314 27 ESP (SPI=0x040001dc)
n 472 61.01606 192.168.2:192.168.2¢ ESP 176 315 27 ESP (SPI=0x040001dc)
12] 473 61.01806 192.168.2:192.168.2¢ ESP 176 316 27 ESP (SPI=0x040001dc)
13 | 474 61.02106 192.168.2:192.168.2¢ ESP 176 317 27 ESP (SPI=0x040001dc)
14 475 61.02205 192.168.2:192.168.2¢ ESP 176 318 27 ESP (SPI=0x040001dc)
15 | 476 61.02306 192.168.2:192.168.2¢ ESP 176 319 27 ESP (SPI=0x040001dc)
16 477 61.02506 192.168.2:192.168.2¢ ESP 176 320 27 ESP (SPI=0x040001dc)
17 | 478 61.02605 192.168.2:192.168.2¢ ESP 176 321 27 ESP (SPI=0x040001dc)
18 479 61.02805 192.168.2:192.168.2L ESP 176 322 27 ESP (SPI1=0x040001dc)
19 480 61.02906 192.168.2:192.168.2¢ ESP 176 323 27 ESP (SPI=0x040001dc)
20 481 61.02906 192.168.2:192.168.2{ ESP 176 324 27 ESP (SPI=0x040001dc)
21 482 61.03005 192.168.2:192.168.2L ESP 176 325 27 ESP (SPI=0x040001dc)
22 483 61.03206 192.168.2:192.168.2L ESP 176 326 27 ESP (SPI=0x040001dc)
23 484 61.03306 192.168.2:192.168.2¢ ESP 176 327 27 ESP (SPI=0x040001dc)
24 485 61.03505 192.168.2:192.168.2¢ ESP 176 328 27 ESP (SPI=0x040001dc)
25 486 61.03606 192.168.2:192.168.2¢LESP 176 329 27 ESP (SPI=0x040001dc)
26 487 61.03905 192.168.2:192.168.2¢ ESP 176 330 27 ESP (SPI=0x040001dc)
27 488 61.04105 192.168.2:192.168.2L ESP 176 331 27 ESP (SPI=0x040001dc)
28 489 61.04206 192.168.2:192.168.2¢ ESP 176 332 27 ESP (SPI=0x040001dc)
29 | 490 61.04406 192.168.2:192.168.2¢ ESP 176 333 27 ESP (SPI=0x040001dc)
30 | 491 61.04606 192.168.2:192.168.2¢ ESP 176 334 27 ESP (SPI=0x040001dc)
31 | 492 61.06305 192.168.2:192.168.2¢ ESP 176 335 27 ESP (SPI=0x040001dc)
32 | 493 61.06505 192.168.2:192.168.2¢ ESP 176 336 27 ESP (SPI1=0x040001dc)
33 | 494 61.06705 192.168.2:192.168.2¢ ESP 176 337 27 ESP (SPI=0x040001dc)
34 495 61.06905 192.168.2:192.168.2¢ ESP 176 338 27 ESP (SPI1=0x040001dc)
35 | 496 61.07105 192.168.2:192.168.2¢ ESP 176 339 27 ESP (SPI=0x040001dc)
36 | 497 61.07105 192.168.2:192.168.2¢ ESP 176 340 27 ESP (SPI1=0x040001dc)
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Tornate al foglio CAP1_slice e create una nuova colonna denominata
COMPARE_ESP_SEQUENCE.

A B | ¢c D E | F | 6 H | | | J | K | L | M | N | © | P | Q@ | R
1 |No. Time Source  Destinatic Protocol Length  ESP Seque Differenti Source Po Destinatic Info Sequence Number COMPARE_ESP_SEQUENCE
2 451 55.44196 192.168.2:192.168.2£ ESP 176 306 27 ESP (SPI=0x040001dc)
3 452 55.44598 192.168.2:192.168.2£ ESP 176 307 27 ESP (SPI=0x040001dc)
.
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Poiché il numero di sequenza ESP si trova nella colonna G, comporre un comando CERCA.VERT
come mostrato per confrontare i due fogli per assicurarsi che tutto nella colonna G sull'origine si
trovi nella colonna G sulla destinazione.

=SE(VAL.NON.DISP(CERCA.VERT(G2;CAP2_slice!G:G;1;FALSO));"MANCANTE","PRESENTE")

x 4 2 =IF{ISNA|VLOOKUP|G2,CAP2_slice!G:G,1,FALSE)),"MISSING","PRESENT")
] c 1] E F G H ! J K L M N ] L4 Q R 5 T u v w X
‘ime Source  Destinatic Protocol Length ESP Seque Differenti Source Po Destinatic Info Sequence Number COMPS = | ESP_SEQUENCE
" 0 -
55.441596 192.168.2:192.168.2{ ESP 1?6l 306_| 7 ESP (5P I=0x040001dc]) |=IF! ISNAIVLOOKUR(G2,CAPZ_slicelG:G,1,FALSE)),"MISSING™,"PRESENT")
55.44598 192.168.2:192.168. 2{ ESP 176 07 7 ESP [SPI=0x040001dc)

Dopo aver selezionato Invio, viene visualizzata la parola PRESENTE. Cio significa che il
pacchetto con sequenza ESP 306 & presente nel secondo foglio. Questo € significativo perché



significa che il pacchetto € stato creato tra l'origine e la destinazione.

| A | B | ¢ | b | E | F | & H I | ) | K | L | M | N | © p aQa R
1 |No. Time Source  Destinatic Protocol Length  ESP Seque Differenti Source Po Destinatic Infa Sequence Number COMPE ~ |_ESP_SEQUENCE
2 451 55.44196 192.168.2:192.168 2 ESP 176 306 27 ESP (SPI=0x040001dc) PRESENT

3 452 55.44598 192.168.2:192.168.28 ESP 176 307 7 ESP (SPI=0x040001dc)

Selezionare Colonna O Riga 2 e posizionare il puntatore del mouse sull'angolo inferiore destro
della casella verde intorno a tale cella.

N 0 p Q | R
COMPARE_ESP_SEQUENCE
3

Selezionare e tenere premuto e trascinare il mouse verso il basso per copiare la formula nella
parte inferiore delle celle contenenti valori.

s £ =IF{IENA(VLOOKUP(G2,CAP2_slice!G:G,1,FALSE]),"MISSING","PRESENT")
B C *] E F G H | ) K L M N Q P Q R s T u v

Time Source  DestinaticProtocol Length  ESP Sequé Differenti Source Po Destinatic Info Sequence Numbar COMPARE_ESP_SEQUENCE

31 55.44196 192.168.2:192.168.2(ESP 176 306 27 ESP |SPI=0x040001dc) PRESENT

52 55.44598 192.168.2: 192.168.2¢ESP 176 307 27 ESP (SP1=0x040001dc)

53 55.44897 192.168.21192.168.26ESP 176 308 27 ESP (5P1=0n040001dc)

4 55.45097 192.168.2: 192.168.2( ESP 176 309 7 ESP |SPI=0x040001dc)

35 55.45296 192.168.2:192.168.2(ESP 176 310 27 ESP |SPI=0x040001dc)

6 55.45896 192.168.2: 192.168.2(ESP 176 3n 27 ESP (SPI=0x040001dc)

¥7 5545597 192.168.2: 192.168.2LESP 176 2 7 ESP (SPI=0x0400014dc)

38 55.45698 192.168.2:192.168.26ESP 176 313 27 ESP (SPI=0x040001dc)

39 5545797 192.168.2: 192.168.2EESP 176 314 27 ESP (SPI=0n040001dc)

0 55.45898 192.168.2:192.168.2EESP 176 315 27 ESP ($PI=0x040001dc)

51 55.46197 192.168.21192.168.2(ESP 176 316 27 ESP |SPI=0xn040001dc)

52 55.46397 192.168.2:192.168.2(ESP 176 317 27 ESP (SPI=0x040001dc)

53 55.46596 192.168.21192.168.2EESP 176 318 27 ESP (SPI=0x040001dc)

¥ 5546697 192.168.2: 192.168.2LESP 176 319 7 ESP (SPI1=0x040001dc)

35 55.46796 192.168.2:192.168.2(ESP 176 320 27 ESP (SPI=0x040001dc)

36 55.46996 192.168.2:192.168.2(ESP 176 321 27 ESP (SPI=0x040001dc)

57 55.47097 192.168.2:192.168.26ESP 176 322 27 ESP [SPI=0x040001dc)
23T JIUULT T ATLAVO.LI LTL LUD. LECIF L I “r CIF | IF I=UassuUAUL ) _I'l\:.lml
540 55.60496 192.168.2:192.168.2{ ESP 176 385 27 ESP (SPI=0x040001dc) PRESENT
541 55.60596 192.168.2:192.168.2{ ESP 176 396 27 ESP (SPI=0x040001dc) PRESENT
542 55.60696 192.168.2:192.168.2{ ESP 176 397 27 ESP (S5PI=0x040001dc) PRESENT
543 55.60696 192.168.2:192.168.2 ESP 176 398 27 ESP (SPI=0x040001dc) PRESENT
544 55.60696 192.168.2:192.168.2{ ESP 176 399 27 ESP (SPI=0x040001dc) PRESENT
545 55.60796 192.168.2:192.168.2{ ESP 176 400 27 ESP (SPI=0x040001dc) PRESENT
546 55.60796 192.168.2:192.168.2{ ESP 176 401 27 ESP (SPI=0x040001dc) PRESENT
547 55.60896 192.168.2:192.168.2{ ESP 176 402 27 ESP (SPI=0x040001dc) PRESENT
548 55.60896 192.168.2:192.168.2f ESP 176 403 27 ESP (SPI=0x040001dc) PRESENT
549 55.60997 192.168.2: 192.168.2¢{ ESP 176 404 27 ESP (SPI=0x040001dc) PRESENT
550 55.61096 192.168.2:192.168.2{ESP 176 405 27 ESP (SPI=0x040001dc) PRESENT

Scorrete il foglio fino alla parte superiore e fate clic su COMPARE_ESP_SEQUENCE. Quindi
selezionare Ordina e filtra.
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Scegliere Filtro dal menu a discesa.
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Nella colonna COMPARE_ESP_SEQUENCE viene visualizzato un menu a discesa.
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Fare clic sul menu a discesa nell'intestazione COMPARE_ESP_SEQUENCE. Si noti che in questo
esempio l'unico valore visualizzato € PRESENCE. Cio significa che tutti i pacchetti sono presenti
in entrambe le clip.
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Per creare un esempio problematico, eliminare 10 pacchetti dalla slice CAP2_slice, per dimostrare
come questa operazione funzionerebbe in un test in cui mancano alcuni pacchetti.



] 4/Z4 DLULDUD 19£.108.4: 194.108.4 ESV 1/0 31> 24 ESF [dPI=UXU4uUUULac)
12 473 61.01806 192.168.2:192.168.2¢ ESP 176 316 27 ESP (SPI=0x040001dc)
13 474_61.02106 192.168.2:192.168.2¢ ESP 176 317 27 ESP (SPI=0x040001dc
14 475 61.02205 192.168.2:192.168.2§ ESP 176 318 27 ' ESP (SPI=0x040001d¢
15 476 61.02306 192.168.2:192.168.2¢ESP 176 319 27 ESP (SPI=0x040001dc
16 477 61.02506 192.168.2:192.168.2§ ESP 176 320 27 ESP (SPI=0x040001d(
17 478 61.02605 192.168.2:192.168.2¢ ESP 176 321 27 ESP (SPI=0x040001d(
18 479 61.02805 192.168.2:192.168.2§ ESP 176 322 27 ESP (SPI=0x040001d¢
19 480 61.02906 192.168.2:192.168.2¢ ESP 176 323 27 ESP (SPI=0x040001d¢
20 481 61.02906 192.168.2:192.168.2¢ ESP 176 324 27 ESP (SPI=0x040001d¢
21 482 61.03005 192.168.2:192.168.2¢ ESP 176 325 27 ESP (SPI=0x040001d(
22 483 61.03206 192.168.2:192.168.2§ ESP 176 326 27 ESP (SPI=0x040001d¢
23 484 61.03306 192.168.2:192.168.2¢ ESP 176 327 27 ESP (SPI=0x040001d(
24 485 61.03505 192.168.2:192.168.2€ ESP 176 328 27 ESP (SPI=0x040001dc)
25 436 61.03606 192.168.25192.168.2¢ ESP 176 329 27 ESP (SPI=0x040001dc)
26 487 61.03905 192.168.2:192.168.2¢ ESP 176 330 27 ESP (SPI=0x040001dc)
27 438 61.04105 192.168.2:192.168.2£ ESP 176 331 27 ESP (SPI=0x040001dc)
28 489 61.04206 192.168.2:192.168.2¢ ESP 176 332 27 ESP (SPI=0x040001dc)
29 430 61.04406 192.168.2:192.168.2¢ ESP 176 333 27 ESP (SPI=0x040001dc)
30 451 61.04606 192.168.2:192.168.2¢ ESP 176 334 27 ESP (SPI=0x040001dc)
31 492 61.06305 192.168.2:192.168.2£ ESP 176 335 27 ESP (SPI=0x040001dc)
32 493 61.06505 192.168.2:192.168.2¢ ESP 176 336 27 ESP (SPI=0x040001dc)
33 434 61.06705 192.168.2:192.168.2¢ ESP 176 337 27 ESP (SPI=0x040001dc)
34 455 61.06905 192.168.2:192.168.2¢ ESP 176 338 27 ESP (SPI=0x040001dc)
35 4% 61.07105 192.168.2:192.168.2£ ESP 176 339 27 ESP (SPI=0x040001dc)
36 497 61.07105 192.168.2:192.168.26 ESP 176 340 27 ESP (SPI=0x040001dc)
37 438 61.07205 192.168.2:192.168.2¢ ESP 176 341 27 ESP (SPI=0x040001dc)
38 439 61.07605 192.168.2:192.168.2¢ ESP 176 342 27 ESP (SPI=0x040001dc)
| caPislice | CAP2slice ©)

Tornate al foglio CAP1_slice e ora sono 10 i pacchetti mancanti.

WS SIS ST RS AL &S AU LR L arw war e L b | LIELTee L

460 55.45898 192.168.2:192.168.2{ ESP 176 315 27 ESP (SPI=0x040001dc) PRESENT
461 55.46197 192.168.2:192.168.2L ESP 176 316 27 ESP (SPI=0x040001dc) PRESENT
462 55.46397 192.168.2:192.168.2¢ ESP 176 317 27 ESP (SP1=0x040001dc) PRESENT
463 55.46596 192.168.2:192.168.2f ESP 176 318 27 ESP (SPI1=0x040001dc)
464 55.46697 192.168.2:192.168.2¢ ESP 176 319 27 ESP (SPI=0x040001dc)
465 55.46796 192.168.2:192.168.2{ ESP 176 320 27 ESP (SPI=0x040001dc)
466 55.46996 192.168.2: 192.168.2f ESP 176 321 27 ESP (SPI=0x040001dc)
467 55.47097 192.168.2:192.168.2¢ ESP 176 322 27 ESP (SPI=0x040001dc)
468 55.47198 192.168.2:192.168.2¢ ESP 176 323 27 ESP (SPI=0x040001dc)
469 55.47297 192.168.2:192.168.2¢ ESP 176 324 27 ESP (SPI=0x040001dc)
470 55.47497 192.168.2:192.168.2 ESP 176 325 27 ESP (SPI=0x040001dc)
471 55.47597 192.168.2:192.168.2¢ ESP 176 326 27 ESP (SPI=0x040001dc)
472 55.47697 192.168.2: 192.168.2¢ ESP 176 327 27 ESP (SPI1=0x040001dc)
473 55.47896 192.168.2:192.168.2f ESP 176 328 27 ESP (SPI1=0x040001dc) PRESENT
474 55.48096 192.168.2:192.168.2¢ ESP 176 329 27 ESP (SPI1=0x040001dc) PRESENT

Quando si seleziona il menu a discesa nella colonna COMPARE_ESP_SEQUENCE, si notera che
anche vi sono pacchetti MANCANTI. Questa opzione puo essere attivata e disattivata per
visualizzare solo i pacchetti MANCANTI.
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Ora solo i pacchetti mancanti vengono visualizzati nel foglio di Excel.
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Informazioni correlate

. Cisco Embedded Packet Capture

| B | C L |

Time Source  Destinatic Protocol Length
55.46596 192.168.2:192.168.28 ESP 176
55.46697 192.168.2:192.168.28 ESP 176
55.46796 192.168.2:192.168.2{ ESP 176
55.46996 192.168.2:192.168.2 ESP 176
55.47097 192.168.2:192.168.2 ESP 176
55.47198 192.168.2:192.168.28 ESP 176
55.47297 192.168.2:192.168.28 ESP 176
55.47497 192.168.2:192.168.2§ ESP 176
55.47597 192.168.2:192.168.2 ESP 176
55.47697 192.168.2:192.168.2¢ ESP 176
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https://www.cisco.com/c/it_it/support/docs/ios-nx-os-software/ios-embedded-packet-capture/116045-productconfig-epc-00.html
https://www.cisco.com/c/it_it/support/index.html

Informazioni su questa traduzione

Cisco ha tradotto questo documento utilizzando una combinazione di tecnologie automatiche
e umane per offrire ai nostri utenti in tutto il mondo contenuti di supporto nella propria lingua.
Si noti che anche la migliore traduzione automatica non sara mai accurata come quella fornita
da un traduttore professionista. Cisco Systems, Inc. non si assume alcuna responsabilita per
I&rsquo;accuratezza di queste traduzioni e consiglia di consultare sempre il documento
originale in inglese (disponibile al link fornito).



